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Worksheets in a Workbook

Insert...
@ A worksheet is a grid made up of rows and columns. BT pelete
@ A worksheet is a page in a workbook. 7 Rename
@ A workbook can have multiple worksheets. Move or Copy...

[l View Code
You can: B:E Protect Sheet...

@ insert a new worksheet. Tab Color >
@ delete a worksheet. Hide
© Be careful: Deleting a worksheet cannot be undone!
@ rename a worksheet. Select All Sheets
© move or copy a worksheet. St EZl Link to this Sheet
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Rows, Columns, and Cells

What are cells, rows, and columns?
@ Rows are horizontal lines.
@ Columns are vertical lines.
@ Cells are the intersection of a row and a column.
)

Cells can have values or references to other cells.
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Insert, Delete, and Clear a Row or Column

@ Choose a row.
@ Right click on the row.
@ Choose insert, delete, or clear contents.

@ You can choose multiple rows or columns at once using shift or ctrl keys.
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Name a Cell

How to name a cell?
@ Go to the cell you want to name.
@ Click the Name Box in the formula bar.

@ Type the name of the cell.

How to use the name of a cell?
@ Use the name of the cell in a formula.
@ Use the name of the cell in a function.

@ Use the name of the cell in a condition.
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Name a Cell: Example

Calculate tax payment for three items using a named cell for the tax rate.
o Cell B1.
@ This should be named TaxRate in the Name Box in the formula bar.

@ Column C: Tax payment (using the named cell TaxRate)

Spreadsheet Structure:

A B C
1 | TaxRate: | 0.06
2
3 ltem Price | Tax Payment on Price
4 Apple 2.50 =C2*TaxRate
5 Banana 1.80 =C3*TaxRate
6 Carrot 1.20 =C4x*TaxRate

In this example, the tax rate (0.06) is stored in cell B2 (named TaxRate). Each item’s
tax payment is calculated by multiplying its price.
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Excel Shortcuts

@ Using shortcuts is much more efficient than using the menu. You are expected to

@ *Mac has different shortcuts. For many of them, Command instead of Ctrl.

use these shortcuts in this course.

Useful shortcuts:
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Ctrl + C:
Ctrl + V:
Ctrl 4+ X:
Ctrl + Z:
Ctrl + VY:
Ctrl + F:
Ctrl + H:
Ctrl 4+ A:
Ctrl + B:

Copy
Paste
Cut

Undo
Redo
Search
Replace
Select All
Bold
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Excel Shortcuts

F2: Edit in a selected cell
F4: Toggle between absolute and relative references

F5: Go to a specific cell

Alt: See shortcuts on the menu bar.
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Excel Shortcuts - Navigation

Ctrl + Home: Go to cell Al
Ctrl + End: Go to the last cell with data

Ctrl + Arrow Keys: Jump to the edge of the data region in the direction of the
arrow

Shift + Arrow Keys: Select cells
Ctrl + Shift 4+ Arrow Keys: Jump while selecting cells
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Excel Shortcuts - Navigation

Play with these shortcuts in your example sheet to see how they help you move and
select data quickly!

AW N =

@ Ctrl + Home: Moves the cursor to cell Al, the very top-left cell of the worksheet.

@ Ctrl + End: Moves the cursor to the last cell that contains data. In this example,
the last data is in cell E5, so Ctrl+End will take you to E5.

@ Ctrl + Arrow Keys: If you start in cell A2 and press Ctrl + Right Arrow, you will
jump to E2 (the next filled cell in that row).

@ Ctrl 4 Shift + Arrow Keys: Starting at A2 and pressing Ctrl + Shift 4+ Right
Arrow will select A2 through E2.
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Data types

1
2
3
4
5
6
7
8
9

10

Text: Letters, words, and sentences

Numbers: Whole numbers, decimals, and fractions

Dates: Calendar dates in various formats

Formulas: Mathematical expressions that calculate values (e.g., =A1+B1)

A B C D
Transaction_ID |Date Transaction_Type |[Amount
1|1/1/2025|Return -27.32
2|1/1/2025|Sale 38.2
3|1/1/2025|Sale 99.77
4|1/1/2025|Return -53.67
5(1/1/2025|Return -46.47
6|1/2/2025|Sale 38.36
7(1/2/2025|Return -3.64
8|1/2/2025|Sale 1.79
9| 1/3/2025|Return -55.89
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Range and Table

@ Any set of cells, rows, or columns can be considered as a range.
@ A table is a collection of data organized in rows and columns.

@ Table formatting and built-in features like auto-update makes data management
easier than regular ranges.

How to create a table?
@ Select the range of data.
@ Go to the Home tab.
@ Click the Format as Table button under Style.
@ Or, use a shortcut Ctrl + T.
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Ex. Data in Range [Lab4-1]

Description:

@ In Excel, there are three primary ways to organize data: a range, a table, and a

pivot table.

@ Data: Sales order data including 100+ sales orders.

Required:
© Create a new column - Invoice Amount.

@ Calculate the sum of the new column.

A B c D E F G

1 Sales_Order_ID| Sales_Order_Date | Sales Employee_ID | Customer_ID Product_Code _fales_Order_Quantity_Sold Product_sale_Price

2 20062 11/22/2024 1007 "2001 72004 12 105

3 20168 12/27/2024 1007 "2001 72005 8 85

4 20383 3/4/2025 1007 "2001 "2004 5 105

5 20564 4/28/2025 1007 "2001 "2002 6 120
o



1. Create a new column - Invoice Amount.

This data is formatted well.

This data has column headers.

But still not formatted as a table.

Type F2 * G2 in a cell H2 to get Invoice Amount.

Of course, we can still use this data to analyze the data.
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F G H
Sales_Order_Quantity Sold| Product Sale_Price |Invoice Amount
12 105!=F2*G2
8 85
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@ Drag cell H2 to the end of the column to get Invoice Amount.
@ Check what we have in cell H4.
@ There is FA4*G4, not F2*G2.
@ It's because of relative reference (covered later).
@ A cell in H refers to the cell in F and G in the same row.
t | F o vty s e e
| . Sales_Order_Quantity_Sold| Product_Sale_Price |Invoice Amount
e |Invoice Amount - 1o 1260
1 W 8 85 680
105 J | 5| 105|=F4*G4 |
85 6 120 720
1inc 5 95 475
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2. Calculate the sum of the new column.
@ Go to the bottom of the column of Invoice Amount.
@ Use sum() function.
@ Select the range of Invoice Amount.
°

Click OK.
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Ex. Data in Table [Lab4-1]

Description:

@ Data is formatted in a better way in a table.

@ Each column has a header with a drop-down arrow (for sorting and filtering).

Required:
© Create a new column - Invoice Amount.

@ Calculate the sum of the new column.

A B D 3 F G

1 sales Order ID - | sales Order Date - | sales_§ . IC - | Customer_ID - | Product_Code - | Sales_ Order_Quantity_Solc - | Product_sale_Price -
2 20062 11/22/2024 1007 D001 "004 12 105
3 20168 12/27/2024|1007 001 005 8 85
4 |20283 3/4/2025 1007 001 2004 5 105
5 |20564 4/28/2025 /1007 %001 "002 6 120
& 20140 12/202024 1006 %002 2001 5 95
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1. Create a new column - Invoice Amount.
@ Type "Invoice Amount” in a cell H1.
@ Type F2 * G2 in a cell H2 to get Invoice Amount.

@ You don’t have to drag the formula to the end of the column!

@ See what's in cell H2.
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2. Calculate the sum of the new column.
@ Table Design (or Design) tab > Total Row.
@ Scroll down to see the total row.
@ Select the button next to the Total value. You can see the list of options.
°

Choose Sum.

H151 M fx~ =-SUBTOTAL(109,[Invoice “
Review View Q Tell me s:r_Quantity_Sold |~ | Product_Sale_Price |~ |InVOIcE v 1
- 149 6 85 510
| Header Row [ | First Column v/ Filter Button 150, 2 105 210
[ |4 Total Row | [] Last Column 5y
1 152
€2  |v/ Banded Rows [ | Banded Columns 153
Data Table Style Options L4
155 |
156 1
< > Sales_Trans = +
D ~ | Customer_ID + | Product_Code ~|sales_C r—— moom om
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Filtering in a Table

@ Click the drop-down arrow in the header of column E.
@ Select 2003 to filter the data to only include 2003.
@ Then, Clear Filter to get all the data back (or simply ctrl + z).

v E
D E | customer_iD -| Product_Code |
| -| Customer_ID -| Product_( 1 2| SortAtoz
2] sortAtoz B

z Zl sotztoA
Zl sotztoA e ,
it by Color
Sort by Color >
4 SZ Clear Filter From "Product_Code"
>
>
Text Filt
Text Filters > ext Eilters >
Search el
Search je
E v =
8 (select AN vl ‘ Ls;;mxu)
2001
a0 5 [J2002
3
(12003 :« 2003
12004 2004
[J2005 (72005
(2006 [12006
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Filtering in a Table - Example

Suppose you are a manager and you would like to evaluate performance of your
employees.

@ How many employees in the data?

@ Who has sold the most?
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Visualization

@ Visualization is the process of creating a visual representation of data.
@ Visualization is useful for communicating data to others.

@ Visualization is also useful for analyzing data.
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Ex. Descriptive Statistics for Retail industry [Lab5-1]

Descriptions

@ The dataset includes information of 500+ firm-year observations.
Required:

© Get descriptive statistics for total assets.

@ Get the histogram of ROA (Net Income / Total Assets).

A B 5 D E F G H 1
1 |GVKEY DataDate Fiscal Year Ticker Total Assets NetIncome Total Revenue SIC Code Company Name
2 37234 20191231 2019 WNW 3.244 -1.755 7.683 5961 WUNOMNG NET TEC COM LTD
3 183307 20201231 2020 SCFFF 3.623 -2.433 4,098 5812 SPOT COFFEELTD CDA
a4 183307 20191231 2019 SCFFF 4.43 -2.514 8.592 5812 SPOT COFFEELTD CDA
5 65482 20190131 2018 STRZ 6.425 -0.541 26.036 5812 STAR BUFFET INC
6 36906 20191031 2019 JZXN 7.066 3.24 7.978 5500 JIUZI HOLDINGS INC -REDH
7 24142 20190630 2019 BTB 10.847 -0.933 0.402 5411 BIT BROTHER LTD
g 31806 20201231 2020 GGBBF 13.888 -7.711 13.777 5600 LXRANDCO INC
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1. Get descriptive statistics for total assets.

@ Data > Data Analysis (which is Analysis Toolpak Add-in)

@ Select Descriptive Statistics.

Fle Home Inset Draw Pagelayowt Formulas Data  Review View Automate Help Anaiytic Solver
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© Select total asset column in the input range.

@ Mark the Summary Statistics checkbox.

Descriptive Statistics
Input
Input Range: SES2:SESTOS

Grouped By: © Columns
(O Rows

[] Labels in First Row

Output options
() Qutput Range:

© New Worksheet Ply:

(O Mew Workbook

8 summary statistics.

(] Confidence Level for Mean: 95
(] Kth Largest: 1

(] kth Smallest: 1

%

8 Advnced

Get & Transtorm Data Queries & Connections Data Tpes Sort & Filter

>

%
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extto =% :hd What-If Forecast
? X
Cancel
Help
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1. Get descriptive statistics for total assets.

Total Assets
Mean 8529.49
Standard Error 1108.26
Median 1266.91
Mode 22360
Standard Deviation 29468
Sample Variance 8.7E+08
Kurtosis 58.431
Skewness 7.27065
Range 321192
Minimum 3.244
Maximum 321195
Sum 6030351
Count 707
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2. Get the histogram of ROA (Net Income / Total Assets).

@ Add ROA column.

2 v S| =F2/E2

A B C D E F G H I J
1 GVKEY Data Date Fiscal Year Ticker Total Assets NetIncome Total Revenue SIC Code Company Name ROA
2 37234 20191231 2019 WNW 3.244 -1.755 7.683 5961 WUNONG NET TEC COM LTD -0.541
3 183307 20201231 2020 SCFFF 3.623 -2.433 4.098 5812 SPOT COFFEE LTD CDA -0.67154
4 183307 20191231 2019 SCFFF 4.43 -2.514 8.592 5812 SPOT COFFEE LTD CDA -0.56749
5 65482 20190131 2018 STRZ 6.425 -0.541 26.036 5812 STAR BUFFET INC -0.0842

@ Select ROA column.
@ Insert > Charts > All Cha
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Critial Thinking:
@ Does the graph look visually appealing?
@ How would you improve the graph?
@ What about descriptive statitistics?

@ How would you improve the descriptive statistics?
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